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New Features
New Features
This section describes the new features and enhancements available in Campus 
Manager 4.0.6. These include:

• Enhanced Homepage

• Setup Center

• Enhanced Device Selector

Enhanced Homepage
The Campus Manager Homepage provides information on the status of Device 
Discovery, Data Collection, and User Tracking Acquisition. 

It also provides information on the physical and logical discrepancies as well as 
the details of the jobs that have been completed recently. You can access the 
frequently used features in the application from the homepage. 

For more details, see User Guide for Campus Manager 4.0.6.

Setup Center
The Setup Center is a centralized location that displays all the System 
configuration related information. 

The Setup Center also allows you to configure and check the necessary server 
settings from a single place.

For more details, see User Guide for Common Services 3.0.5.

Enhanced Device Selector
The new Device Selector allows you to perform search and advanced search for 
devices based on specified search criteria. 

For more details, see User Guide for Common Services 3.0.5.
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Product Documentation
Product Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should also review the documentation on Cisco.com 
for any updates.

Table 1 describes the product documentation that is available.

Table 1 Product Documentation

Document Title Available Formats

Quick Start Guide for 
LAN Management Solution 2.6

• Printed document that was included with the product.

• On Cisco.com at:
http://www.cisco.com/en/US/products/sw/cscowork/ps2425/
prod_installation_guides_list.html

Data Migration Guide for LMS 2.6 • Printed document that was included with the product.

• On Cisco.com at this URL:

http://www.cisco.com/en/US/products/sw/cscowork/ps2425/
prod_installation_guides_list.html

User Guide for 
Campus Manager 4.0.6

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
products_user_guide_list.html

• Printed document available by order (part number 
DOC-7817186=).1

Supported Devices Table for 
Campus Manager 4.0.6

On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
products_device_support_tables_list.html
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Product Documentation
Installation and Setup Guide for 
Campus Manager 4.0.6 on 
Windows

• Printed document that was included with the product.

• PDF on the product CD-ROM.

• On Cisco.com at this URL:
http://cisco.com/en/US/products/sw/cscowork/ps563/
prod_installation_guides_list.html

• Printed document available by order (part number 
DOC-7817188=).1

Context-sensitive online help • Select an option from the navigation tree and click Help.

• Click the Help button in the dialog box.

1. See the “Obtaining Documentation” section on page 57.

Table 1 Product Documentation (continued)

Document Title Available Formats
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Related Documentation
Related Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should also review the documentation on Cisco.com 
for any updates.

Table 2 describes the additional documentation that is available.

Additional Information Online
The following product specific information is available online:

Service Packs (SP) contain updated files necessary for the latest device support 
and fixes to known problems that are not available in Campus Manager 4.0.6. If 
you are a registered user, you can download SP for Campus Manager from:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-campus

Table 2 Related Documentation

Document Title Description and Available Formats

User Guide for CiscoWorks 
Common Services 3.0.5

Describes CiscoWorks Common Service 3.0.5. It gives an 
overview of the applications that comprise Common Services 
3.0.5 and provides conceptual information about network 
management. 

This also describes common tasks you can accomplish with 
Common Services. This document is available in the following 
formats: 

• PDF on the product CD-ROM.

• On Cisco.com at:
http://www.cisco.com/en/US/products/sw/cscowork/ps3996/
products_user_guide_list.html
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Support Information
Support Information
Campus Manager 4.0.6 supports only US-English and Japanese versions of 
Windows Operating Systems. It does not support any other language version. Set 
the default locale to US-English for US-English version and Japanese for 
Japanese version.

Known Problems
This section describes the known problems in this release:

• General Notes and Known Problems, page 7

• General Known Problems, page 8

• Browser Known Problems, page 17

• Path Analysis Known Problems, page 18

• User Tracking Known Problems, page 24

• Topology Services Known Problems, page 29

• ANI Server Known Problems, page 43

• VLAN Port Assignment Known Problems, page 48

• Spanning Tree Protocol Known Problems, page 50

Note To obtain more information about known problems, access the Cisco Software 
Bug Toolkit at http://www.cisco.com/cgi-bin/Support/Bugtool/home.pl. (You will 
be prompted to log into Cisco.com.)
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Known Problems
General Notes and Known Problems
Note the following:

• Your browser must be properly configured. If it is not properly configured, 
Campus Manager might not work correctly. For more details, see the 
Installation and Setup Guide for Campus Manager 4.0.6.

• Campus Manager requires a DNS server to function properly. Many 
commands operate erratically or not at all, if there is no DNS server on the 
network.

• You cannot run Campus Manager from a browser invoked from an X-Window 
System since this is not supported. Install a browser on the client from which 
you wish to connect.

• You can upgrade your operating system (OS) either before or after you 
upgrade Campus Manager. However, if you upgrade the OS after upgrading 
Campus Manager, you will not receive any OS-related patch warnings or 
service pack-related warnings.

• Verify that the latest version of all required OS patches, service packs, and 
third-party device drivers are installed before proceeding with an OS 
upgrade.

• Do not export an entire topology map to Visio. Instead, select and export 
particular devices or a segment of the network and export it.
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Known Problems
General Known Problems
The table below lists the known problems that are not specific to any module in 
Campus Manager.

Table 3 General Known Problems

Bug ID Summary Explanation

CSCsc49501 VeriSign security certificate 
displays expiry warning 
message.

The VeriSign security certificate expires in June 
2006. After that date, Campus Manager will 
display the Certificate expiry message whenever 
you launch applet based pages. 

However, all modules in Campus Manager will 
continue to work.

Workaround:

Ignore the message.

CSCsb86066 Topology and Path Analysis do 
not launch when NAT or firewall 
are configured.

If Campus Manager is installed in a server with 
NAT or firewall, Topology and Path Analysis do 
not launch. The following message appears:

Cant connect to ANI Sever

Workaround:

If you enable the ports supported by Common 
Services, Topology and Path Analysis work in a 
firewall setup. 

For details on these ports, see Installation and 
Setup Guide for Common Services 3.0.5 (Includes 
CiscoView) on Windows.
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Known Problems
CSCsc24255 Improper error message while 
configuring IVR.

This problem occurs in the following scenario:

If you do not give proper SNMP or Telnet 
credentials for a device in DCR, RME does not 
fetch Config details from that device. 

When you try to configure IVR for that device in 
Campus Manager, the following error message 
appears:

Failed in export/Import config.

Workaround:

Enter proper SNMP and Telnet credentials for the 
device in DCR.

CSCsb28190 Campus Manager applications 
do not start in ACS mode.

Topology Services, Path Analysis, VLAN Port 
Assignment, and Discrepancy Report tasks do not 
start when you login to CiscoWorks in ACS mode. 

This problem occurs if you select Assign a 
Ciscoworks on a per Network Device Group 
Basis option in ACS server, but in the selected 
device group, you do not add the CiscoWorks 
server IP address.

Workaround:

When you assign a user to a specific group, ensure 
that you add the CiscoWorks Server IP address to 
that device group.

CSCsa80727 Sometimes, launching of 
Campus Manager UIs fails.

Campus Manager UIs did not open when the 
daemon manager is not restarted for a long period 
of time.

Workaround:

1. Stop the daemon manager. 

2. Wait for 10 minutes and start the daemon 
manager.

Campus Manager UIs now open properly.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCsa59569 Restoring Campus Manager files 
fails when path of the backup.pl 
file is in lower case.

When path of the backup.pl file, is provided in 
lower case, Campus Manager successfully backs 
up the files, but does not restore the files.

This is because during restore, NMSROOT 
verification of the tar file fails, which stops the 
Campus restore.

Workaround:

You must execute 
NMSROOT/objects/db/conf/configureApp.pl 
before backing up the files using backup.pl.

CSCsa22708 Campus Manager does not 
manage existing devices when 
you upgrade from higher device 
limit to lower device limit.

This problem occurs because Campus Manager 
performs a fresh discovery of the network to 
obtain the devices and does not import them from 
the earlier versions.

Workaround:

None.

CSCin23883 Jobs created in Path Analysis or 
User Tracking appear in the Job 
Management page even after 
uninstalling Campus Manager.

If you have scheduled Path Analysis or User 
Tracking jobs and then uninstall Campus, the jobs 
are not deleted from the CiscoWorks Job 
Management page.

Workaround;

Delete the Path Analysis or User Tracking jobs 
from the Job Management page.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCsa44629 Campus Manager does not 
restore Topology Map settings 
after you take a backup and 
restore the data on another 
machine, that has Campus 
Manager 4.0.

Campus Manager does not save the changes to 
layout style and background colors in Topology 
Map settings, that were backed up in another 
machine.

This occurs when you:

1. Modify Topology Map settings on a machine 
with Campus Manager 3.3.

2. Back up and restore the files on another 
machine, that has Campus Manager 4.0.

3. Run Data Collection.

4. Start Topology Services.

Workaround:

1. Run 
NMSROOT/campus/conf/upgrade/cm/topo/
2cm31maplayout.pl on the machine with 
Campus Manager 3.3 to generate the map 
files.

2. Copy the map files to the location on the target 
system, where you have restored the data: 
NMSROOT/campus/etc/users/username/

3. Upgrade Topology Map by selecting File > 
Upgrade View Layouts from Topology 
Services.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCdu51651 You cannot select the first 
template from the drop-down 
box, when you create 
SPVC/SPVP/Advanced 
parameters.

Under ATM if you create SPVC/SPVP/Advanced 
parameters, you cannot select the first template 
from the drop-down box. This is because the 
traffic parameter fields are not populated.

Workarounds:

1. Go to Select/Edit and select the template.

2. Click OK.

Or

1. Select the second template

2. Select the first template.

CSCdt55303 Starting Campus Manager 
application with the Print dialog 
box open in another Campus 
Manager application results in 
an error.

This problem occurs if you:

1. Select Print from active Campus Manager 
application.

2. Start another instance of Campus Manager 
application, with the Print dialog box open.

The new application window does not respond 
to user input.

Workaround:

Close the Print dialog box and restart the 
application.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCdt42318 Cannot copy and paste IP 
addresses from Topology 
Services to Path Analysis when 
you use keyboard shortcuts.

This problem occurs if you:

• Enter Ctrl-C to copy address after selecting 
an IP address in Topology Services,

Or 

• Enter Ctrl-V with the cursor active in the 
From field in Path Analysis.

In both cases the following is pasted in instead of 
the IP address:

java.lang.nullPointerException

Ctrl-X, Ctrl-C, and Ctrl-V (keyboard shortcuts for 
cut, copy, and paste commands) are not supported 
by summary tables in the Topology Services Main 
Window

It is also not supported by most of the tables that 
are displayed by Campus applications.

Also, in applications that allow you to copy 
support table cells by selecting Edit > Copy, a 
carriage return is added to the end of the last cell 
copied.

Workaround:

None.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCdt22462 Download of Java applets on 
Windows 2000 machines may 
take longer than expected if virus 
checker application is enabled.

On some Windows systems, the initial download 
of large Java applets (or subsequent downloads of 
the same applets that are not cached locally) might 
take longer than expected (up to six minutes in 
some instances). 

After the applet has been loaded and cached 
locally, the problem no longer occurs.

The delay is caused by client side filtering 
mechanisms such as virus scanning. Some virus 
scanners are configured to automatically scan 
content downloaded by browsers. Scanning 
consumes a lot of memory and results in disk 
paging on most systems.

Owing to this, downloading is significantly slower 
than expected. (The effect is less on systems with 
large amounts of RAM and virtual memory.)

Workaround:

Disable the automatic scanning of all downloaded 
files, and instead enable the scanning of program 
files only (specified by file extension).

Exact instructions vary depending on the virus 
scanner installed on your system.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCds88388 Cannot launch CiscoView on an 
IGX series device.

This occurs if you:

1. Launch Topology Services.

2. Open LAN Edge view.

3. Right-click on IGX series device and select 
CiscoView from the Context menu.

A dialog box appears. 

4. Enter appropriate community strings, and 
CiscoView attempts to launch. 

An error message appears.

Workaround:

Launch CiscoView on IGX series devices using 
Cisco WAN Manager.

CSCdm88520 Minimized windows are not 
visible when you select them 
from a Window menu.

If a window is minimized, you cannot make it 
visible by selecting it from a Window menu. 

Workaround: 

Click the icon of the window in the taskbar.

CSCdm83204 Campus Manager applications 
do not work when you access 
CiscoWorks using 
http://localhost:1741

If you access CiscoWorks applications using 
http://localhost:1741 from a browser on the 
same machine that CiscoWorks server is installed 
on, Campus Manager suite of applications will not 
work.

Workaround:

Use full DNS name or IP address of server, even 
when accessing it locally.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCdm77812 In Path Analysis, Tools > Path 
Trace displays an error,
null pointer exception on 
Microsoft Internet Explorer 5.0 
with the URL of a local host.

If your system has a non-blank CLASSPATH 
environment variable, your browser might behave 
unpredictably.

Workaround:

Reset the CLASSPATH variable non-globally:

• Solaris— Reset the CLASSPATH variable 
from the terminal window from where you 
launch the browser.

• Windows—Reset the CLASSPATH variable in 
MS-DOS prompt window and launch the 
browser from the prompt.

Table 3 General Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
Browser Known Problems
The table below lists the browser related known problems existing in 
Campus Manager.

Table 4 Browser Known Problems

Bug ID Summary Explanation

CSCin39472 Problems with Campus Manager 
applications after logout.

When you logout from CiscoWorks, 
Campus Manager applications will continue to 
function. However, the following functions will 
not be available:

• Launching Help.

• Tasks in Campus Manager that require user 
action between applications. For example, 
highlighting a device in Topology Services 
using Path Analysis.

Workaround:

1. Close all Campus Manager applications.

2. Login into CiscoWorks.

3. Launch Campus Manager applications.

CSCdt11838 You are not prompted to install 
the Java plug-in when launching 
an application that utilizes the 
plug-in for the first time.

If RealJukebox Plug-in for Navigator is already 
installed on a Windows client before the first 
launch of application utilizing Java Plug-in, you 
are not prompted to install Java Plug-in.

Workaround: 

Uninstall RealJukebox Plug-in. 

You can also rename nprjplug.dll file in Navigator 
Plug-ins directory with a new extension. For 
example, nprjplug.dll.bak. 

After Java Plug-in is installed, you can reactivate 
RealJukebox Plug-in by changing the renamed file 
back to nprjplug.dll.
17
Release Notes for Campus Manager 4.0.6 on Windows

OL-11282-01



 

Known Problems
Path Analysis Known Problems
The table below lists the Path Analysis related known problems in Campus 
Manager.

CSCdp43999 Maps and configuration dialogs 
display offset menus and list 
boxes in Netscape on a Solaris 
client.

Sometimes, when you launch a map or a 
configuration dialog box, menus or list boxes are 
not displayed below the menu. This offset occurs 
in Navigator on a Solaris client.

Workaround:

Move or resize window.

Table 4 Browser Known Problems (continued)

Bug ID Summary Explanation

Table 5 Path Analysis Known Problems

Bug ID Summary Explanation

CSCin37960 VLAN-to-Subnet mapping 
information is not available for 
Phone Traces.

Path Analysis does not provide VLAN-to-Subnet 
mapping information, when you run Path Trace 
between two IP phones.

Workaround:

None.

CSCin37938 Interface Type displays Unknown 
for phones in Path Analysis 
Table.

This problem occurs when you run Path Traces 
between IP Phones or between a device and IP 
Phone.

Workaround:

None.

CSCin36082 Additional hop appears when 
you perform a trace using HSRP 
virtual IP address.

An additional hop appears if you perform a trace 
by providing an HSRP virtual IP address as the 
source or destination in the path trace.

Workaround:

None.
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Known Problems
CSCin35773 Map displays self loop when 
routing loop occurs.

Occasionally, when the potential first hop learnt 
by Path Analysis is not discovered successfully by 
ANI, the map displays a self loop.

Workaround:

None.

CSCin30899 Path Analysis does not work 
when LSR Traceroute is 
disabled.

If you disable source route on routers, Path 
Analysis sometimes might not display the route 
occasionally.

Workaround:

None.

CSCin28223 CORBA related error message is 
logged into the log file during 
path trace.

Occasionally, during path trace, a CORBA related 
error message is logged into the ani.log file.

Workaround:

Close the client browser window and relaunch 
Path Analysis.

CSCin00624 Path trace involving HSRP 
router results in an empty If 
Index entry in the Path Analysis 
table.

This problem occurs when you run a Path trace 
that includes the IP address of an HSRP router in 
the From field of a path trace.

Workaround:

None.

Table 5 Path Analysis Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCdw15555 Voice trace does not get Cisco 
CallManager cluster information 
if Cisco CallManager HTTPD 
shuts down.

Path Analysis Voice Trace needs to query Call 
Managers known to ANI to check what the cluster 
membership is.

This is done through a HTTP query.

As a security precaution, you might disable the 
Web Server on all cluster members except one. 
This is because Cisco CallManagers use IIS, and 
can be badly damaged by viruses such as Code 
Red and NIMDA.

However, if cluster members have Web Server 
shut off, then Path Analysis cannot obtain 
information on cluster membership and cannot 
retrieve CDRs.

Workaround:

Turn the Web Server on the Cisco CallManager 
back on.

Table 5 Path Analysis Known Problems (continued)

Bug ID Summary Explanation
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CSCdw03410 Path Voice Trace does not 
consider transcoding points.

Current Campus Path Analysis Voice Trace is 
valid only in the case where the two endpoints are 
IP Phones registered with the same Cisco 
CallManager cluster.

For other cases (involving transcoding), Path 
Analysis Voice Trace does not get correct path 
information. 

Examples: 

• Phone call from IP phone to POTS phone off 
H.323 gateway (e.g. 3640) 

• Phone call from one Cisco CallManager 
cluster to another.

In such a case the path would be:

a. From phone 1 to Cisco CallManager 1

b. From Cisco CallManager 1 to Cisco 
CallManager 2 through H.323 
inter-cluster trunk

c. From Cisco CallManager 2 to phone 2

• Phone call to gateway (PSTN, analog, etc.) 

• Phone call to other servers (voice mail, 
conference, etc.)

This is a very complex issue, and may require new 
instrumentation from telephony servers, etc.

Workaround:

None.

Table 5 Path Analysis Known Problems (continued)

Bug ID Summary Explanation
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CSCdt42600 To and From fields may not 
function properly after selecting 
Print in Path Analysis. 

This problem is caused by Java Virtual Machine 
bug. After you select Print in Path Analysis, the 
To and From fields may not accept mouse focus, or 
focus may appear in both fields, simultaneously. 

Workaround:

Resize the Java console window. If the problem 
persists, close the Path Analysis window and open 
another window. 

CSCdt42404 Trace tab displays GMT as time 
zone, although server is set to 
local time zone.

A number of Java bugs involve incorrect 
interpretation of time zones. Usually, the correct 
time zone appears if you set the local time zone to 
the appropriate three-letter abbreviation. For 
example, PST for Pacific Standard Time.

This problem is observed on Solaris clients with 
TZ environment variable set to American/Tijuana. 

Workaround:

If the TZ environment variable is instead set to 
PST8PDT, Java interprets local time zone 
correctly.

CSCdt23712 Path Analysis displays the Elvis 
module of Cisco Catalyst 6000 
devices as unknown.

Since Path Analysis depends on ANI for its tracing 
capabilities, if a device-related discovery problem 
occurs in ANI, it results in an unsuccessful trace.

Workaround:

None.

CSCdt04978 Highlighted path trace in 
Topology Services map may be 
difficult to view.

It may be difficult to view highlighted path trace 
in Topology Services map, specially if you select 
the Fit to Window view.

Workaround:

Zoom into Topology Services Map view by 
selecting 
Select All Highlighted Objects > Zoom to 
Selected.

Table 5 Path Analysis Known Problems (continued)

Bug ID Summary Explanation
22
Release Notes for Campus Manager 4.0.6 on Windows

OL-11282-01



 

Known Problems
CSCds79693 Voice trace query results always 
appear using local time zone. 

Local time zone always appears in voice trace 
query results, even if you select GMT time zone 
when specifying call start time. 

Workaround:

None.

CSCds77461 Call Detail Records (CDR) 
query results are sometimes 
displayed after pressing Cancel.

Multiple threads are launched to query every 
Cisco CallManager for information specified in 
your CDR query. 

Since all query activities can take a second or two 
to cancel, query results sometimes continue to 
appear even after you press Cancel.

Workaround:

None.

CSCds77438 Path Analysis Map tab does not 
refresh properly.

This problem occurs when running both the client 
and the server on the same machine. It occurs after 
running a large number of Path traces on the client 
browser.

Workaround:

Close browser and relaunch Campus Manager.

We recommend that you run the client and server 
on different machines. 

Although this does not prevent this problem, it 
reduces its frequency because you need to run a 
large number of traces before the problem occurs.

Table 5 Path Analysis Known Problems (continued)

Bug ID Summary Explanation
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User Tracking Known Problems
Information displayed in a row might not reflect the most current network state. 
This is because User Tracking discovery takes information from routers and 
switches. 

Since these switches collect their information at different times, the information 
in a row reflects the state of the network or subnet at the time displayed in the Last 
Seen field.

The table below lists other User Tracking related known problems existing in 
Campus Manager.

Table 6 User Tracking Known Problems

Bug ID Summary Explanation

CSCsb17074 User Tracking does not discover 
hosts connected to devices with 
SNMPv3 credentials.

When you manage the devices Cisco 
Catalyst 3750 and Cisco Catalyst 4000 with 
SNMPv3 Credentials in Campus Manager, and if 
there are end hosts connected to these devices, the 
end hosts are not discovered and shown by User 
Tracking. 

Workaround:

None.

CSCsc49155 User Tracking report generator 
displays error for some Custom 
queries. 

If you run a custom query on User Tracking 
reports after remote migration, an error message 
appears.

Campus Manager 3.x allows you to create some 
queries that are not supported by CM 4.0.x. Hence, 
an error is displayed when you run the queries.

Workaround:

Delete the old queries created in 
Campus Manager 3.x, and create new queries.
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CSCsc54306 User Tracking discovery spans 
more than the specified subnet.

When you start subnet discovery of user nodes, 
devices in that subnet are marked for discovery. 

Since switches support multiple VLANs, 
discovery could span more than the subnet that 
you selected. User Tracking discovers additional 
end host nodes that are not in the selected subnet.

Workaround:

Query only the required VLAN option in the 
subnet discovery window.

CSCsa30812 Job reports are not available after 
upgrading to 
Campus Manager 4.0.

Reports for the jobs that are successfully 
completed in Campus Manager 3.3 are not 
available after upgrading to Campus Manager 4.0.

This is because of the change in format of the 
Reports in Campus Manager 4.0. 

In earlier versions of Campus Manager, job results 
were stored in plain text, whereas in 
Campus Manager 4.0, the results are stored in 
serialized objects.

Workaround:

None.

CSCsa27118 User Tracking Report displays 
Port State as Static for dot1x 
authenticated ports.

User Tracking Report displays Port State as Static 
when an end host is connected to the switch port, 
which is configured for dot1x authentication.

This is because the device populates vmVlanType 
as Static for dot1x authenticated ports.

Workaround:

None

Table 6 User Tracking Known Problems (continued)

Bug ID Summary Explanation
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CSCsa20659 Purge Job is created although 
you delete it from User Tracking 
Report Jobs.

In User Tracking, Purge Job is created even if you 
try to delete it from the User Tracking Report Jobs 
and Common Services JRM pages. 

It gets deleted and then recreated immediately. 
There is no functionality loss because of this.

Workaround:

None.

CSCsa14652 NAM and IDS Modules appear 
as end hosts in User Tracking.

Cisco Catalyst 6000 devices running native IOS 
service modules appear as end hosts in User 
Tracking. 

This is caused by a problem on the device. 

Workaround:

None.

CSCin00363 End host does not appear if 
obsolete device IP address is 
assigned.

If you connect a CDP device to the port and then 
add a new end host, this new end host is not learnt. 
This is because ANI is not aware of such a change. 

Workaround: 

1. Delete the specific device. 

2. Perform Data Collection for the neighboring 
devices. 

3. Perform User Tracking discovery for that 
device. 

CSCin00181 Last Seen field gets updated for 
disconnected IP phones.

The Last Seen field in Phone Tracking 
corresponds only to the Last Seen field on Cisco 
CallManager and not to the Last Seen field on 
Network.

Workaround: 

None.

Table 6 User Tracking Known Problems (continued)
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CSCec59408 Campus Manager does not query 
CISCO-PORT-SECURITY-MIB 
to verify port security 
configuration.

In User Tracking, configuring port security for a 
port makes the CAM entry static. When port 
security is configured, Campus Manager does not 
query CISCO-PORT-SECURITY-MIB.

This is because of a device specific MIB 
implementation problem. 

Workaround:

Upgrade to Cisco IOS Release 12.2(18)EW1 or 
12.2(20)EW.

CSCdw04499 End hosts are not discovered 
with Catalyst 3550 running 
Cisco IOS Release 12.1(6)EA1 
or earlier.

End hosts are not discovered with Catalyst 3550 
XL running Cisco IOS Release 12.1(4)EA1 and 
Cisco IOS release 12.1(6)EA1.

Workaround:

This problem has been fixed in Cisco IOS 
release 12.1(6)EA1a. Upgrade to this version.

CSCdw04486 End hosts not discovered with 
Catalyst 2950 running a software 
release earlier than Cisco IOS 
Release 12.0(5)WC2.

End hosts not discovered with Catalyst 2950 
running a software release earlier than Cisco IOS 
Release 12.0(5)WC2.

Workaround:

This problem has been fixed in Cisco IOS 
Release 12.0(5)WC2. Upgrade to this version.

CSCdt25525 User Tracking Main Table 
sometimes displays 
CDP-enabled devices that are 
outside the ANI discovery 
boundary.

During User Tracking discovery, User Tracking 
reads entries from the CAM table. These entries 
may include MAC addresses of devices that fall 
outside the ANI discovery boundary. 

Workaround:

None.

Table 6 User Tracking Known Problems (continued)

Bug ID Summary Explanation
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CSCdt06183 User Tracking Main Table may 
not display all entries that are 
displayed in the phone table.

User Tracking entries shown in the Main Table are 
discovered from network. However, User Tracking 
entries shown in the phone table are read from 
Cisco CallManager.

If User Tracking cannot discover particular 
phones in network, entries for such phones in the 
User Tracking phone table will not have device 
and port information.

Workaround:

Ensure that the switch to which the IP Phones are 
connected, is managed by Campus Manager.

CSCdr85384 Phone entries displayed by User 
Tracking differ from entries 
displayed by Cisco CallManager.

User Tracking phone entries acquired through 
SNMP for each Cisco CallManager may be 
different from entries in Cisco CallManager.

The Cisco CallManager database displays a 
historical record of all phones registered to Cisco 
CallManager. 

The SNMP agent retains only records of phones 
registered since the agent was started. This 
accounts for any differences.

Workaround:

None.

CSCsd58215 DNS resolution for end user 
entries takes inordinate amount 
of time.

DNS resolution, which occurs for end hosts 
discovered in user tracking, takes a lot of time to 
timeout if the DNS resolution for the 
corresponding IP address is not available in the 
DNS Server.Campus does not exit without waiting 
for a response from the DNS Server.

Workaround:

Set the property Ani.resolve=false in 
ANIServer.properties.

Table 6 User Tracking Known Problems (continued)
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Topology Services Known Problems
The table below lists the Topology Services related known problems in Campus 
Manager.

CSCse79161 User Tracking  does not  discover 
endhosts using SNMPv3  if the 
endhosts are connected to some 
of the Catalyst IOS devices  such 
as  Catalyst 2900, Catalyst 4000 
and Catalyst 6000.

This problem is  caused by insufficient support for 
SNMPv3 - VLAN based context names in Catalyst 
IOS devices.

Workaround:

This  problem has been fixed in recent Catalyst 
IOS image versions 12.2 and above  for some 
devices. So ensure that  the devices are running 
these versions of Catalyst IOS.

Also, check  whether  the image supports 
SNMPv3 - VLAN based indexing for those device 
types. 

If the device does not have support for 
SNMPv3 - VLAN based context names in Catalyst 
IOS, remove SNMPv3 credentials from DCR and 
manage the device using SNMPv2.

Table 6 User Tracking Known Problems (continued)

Bug ID Summary Explanation

Table 7 Topology Services Known Problems

Bug ID Summary Explanation

CSCdr28017 Topology Services does not 
support clusters of devices.

Clusters of devices, that is, sets of devices grouped 
together under the same IP management address, 
are not supported in Topology Services

Workaround:

None.
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CSCsa80409 Campus Manager Telnet and 
SSH do not support 
Windows 2003 and XP clients

Telnet and SSH fail to launch from the 
Campus Manager Topology Map.

This occurs on Windows 2003 and Windows XP 
clients.

Workaround:

None.

CSCsa37595 Cannot delete large number of 
devices from Topology Services.

An error message appears when you try to delete 
more than 100 devices from VTP Domain View in 
Topology Services.

Workaround:

We recommend that you reinitialize the database 
instead of deleting large number of devices 
through the User Interface.

CSCsa27318 Topology Services displays an 
error, OutOfMemoryError, while 
working with 3000 devices.

When you save the layouts and re-start topology 
map after using Topology Map tools such as zoom 
and drag, Java console displays an error: 
java.lang.OutOfMemoryError.

Workaround:

1. In the Java Plugin Control panel, go to the 
Advanced tab.

2. Add Xmx512m to the existing Java Runtime 
Parameters.

CSCsa25203 Campus Manager does not 
generate Time Domain 
Reflectometry (TDR) Report for 
Cisco 3750 and Cisco 4000 
series switches.

Campus Manager displays a blank report when 
you run TDR test on Cisco 3750 and Cisco 4000 
series switches.

This is because MIBs are not available to support 
TDR feature on these devices.

Workaround:

None.

Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation
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CSCsa22699 Inter-VLAN Routing 
configuration user interface (UI) 
does not differentiate primary 
and secondary IP addresses.

Inter-VLAN Routing configuration user interface 
shows multiple entries for the same interface when 
you configure primary and secondary IP addresses 
for SVI or sub-interfaces.

The UI does not clearly differentiate the primary 
and secondary IP addresses.

Workaround:

This problem does not occur in Cisco IOS Release 
12.1(20)E3 or later.

CSCsa18405 In PVLAN configuration, the 
secondary VLAN creation and 
association to Primary VLAN 
fail on Cisco Catalyst Operating 
System version 8.1.

In devices with Cisco Catalyst Operating System 
version 8.1, Secondary VLAN creation and 
association with Primary VLAN fail if the device 
is running on version VTP version 3.

Workaround:

Either: 

• Upgrade to Cisco Catalyst Operating System 
version 8.2.

Or

• Change VTP version to 2 and VTP mode to 
transparent.

Table 7 Topology Services Known Problems (continued)

Bug ID Summary Explanation
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CSCsa12292 VLANs are not loaded for STP 
Offline Computation.

This problem occurs in Topology Services when 
you:

1. Launch STP Offline for PVST From the 
Topology Map.

2. Go to Reports > VLAN STP > 
Recommendations > STP Offline

3. Click Select Instance.

No VLANs are loaded.

Devices that do not support 
CISCO-STP-EXTENSIONS-MIB will not 
support any STP related functionality.

Workaround:

None

CSCsa11888 Channel or Trunk cannot be 
configured because of STP 
recalculation.

Campus Manager sets the channel mode to 
Desirable Non-silent on the selected devices to be 
channelled. However, STP state changes occur 
when any mode change happens.

So, if one of the two devices of the channel is an 
end-device and is only reachable through the 
to-be-channelled links, the device cannot be 
reached until the spanning-tree converges.

Workaround:

None.

Table 7 Topology Services Known Problems (continued)
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CSCsa10216 Incorrect VTP version displayed 
in VTP reports.

This problem occurs in Topology Services:

The VTP Report displays the VTP version as 1 
while the actual VTP version running on the 
device is VTP version 2. 

This issue is seen only with some of the Cisco 
Catalyst platforms such as Catalyst 4506, 
Catalyst 3750G, Catalyst 2900.

Workaround:

None.

CSCsa04026 Link line or connection between 
two devices gets warped, if one 
device is moved.

This problem is seen in Topology services display 
map. When there is a long line between devices 
and one of the device is dragged to a different 
location on the map, a kink in the line develops 
with the link line connecting these two devices 
getting warped. 

The line appears jagged, instead of being straight.

Workaround:

To avoid this behavior, have devices closer to each 
other.

CSCin68983 Cannot configure Trunk between 
Catalyst 2900XL and Catalyst 
3500XL devices.

Trunk configuration fails between Catalyst 
2900XL and Catalyst 3548XL series switches.

This is caused by lack of MIB support.

Workaround:

None.

CSCin48159 Cannot launch IDSM from 
Service Modules launch point 
for IDSM2 card of Cisco 
Catalyst 6000 device.

From Topology Services, you cannot start IDSM 
using the Service Module launch point. This is 
because of a defect in SNMP agent of the device.

Workaround:

None.

Table 7 Topology Services Known Problems (continued)
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CSCin46641 Campus Manager does not 
calculate Trunk mode related 
discrepancies.

Topology Services does not report the following 
discrepancies for Cisco Catalyst 2900 series, 3500 
series, and 4000 IOS devices, in Trunk mode.

• AutoTrunk

• NoTrunk

• TrunkNegotiationEnabled

This is because of the lack of MIB support in the 
devices.

Workaround:

None.

CSCin46405 Campus Manager does not report 
Spanning Tree discrepancies for 
some devices.

Campus Manager does not report the following 
Spanning Tree discrepancies for some devices:

• BackboneFastDisabled

• UplinkFastDisabled

• BPDUGuarDisabled

• STPEnabledOnAccessPorts

This is because of lack of MIB support in the 
devices.

Workaround:

None.

CSCin46370 Trunk Negotiation Enabled 
Discrepancy Report does not 
show the Trunk mode details of 
the ports of some devices.

TrunkNegotiationEnabled Discrepancy Report 
does not show Trunk mode details of the ports on 
Cisco Catalyst 2950, Cisco Catalyst 3550, and 
Cisco Catalyst 4000 IOS devices. 

This is because of a defect in SNMP agent of the 
device.

Workaround:

None.

Table 7 Topology Services Known Problems (continued)
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CSCin45496 Campus Manager does not report 
UDLD discrepancy for Cisco 
Catalyst 2900 series switches.

Discrepancy Reports does not display UDLD 
disabled discrepancy for Cisco Catalyst 2900 
switches.

This is because of a defect in SNMP agent of the 
device.

Workaround:

None.

CSCin45070 Launch points do not work if 
http/https ports have other than 
the default value.

In Topology Services, the launch points for 
Service Modules function only if the http/https 
port numbers are set to their default value.

Launch Points must function for any valid 
http/https port number configured on the service 
modules.

Workaround:

None.

CSCin43965 Spanning Tree reports more than 
one root for a switch cloud.

Spanning Tree reports more than one root for a 
switch cloud containing Cisco 2900XL, Cisco 
3500XL, Cisco 2950, or Cisco 3550 devices, if the 
selected VLAN is not assigned to any of the ports 
in these devices.

This is because of a defect in SNMP agent of the 
devices.

Workaround:

None.

Table 7 Topology Services Known Problems (continued)
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CSCin36988 Cannot calculate utilization of 
VCs in tunnel.

This problem occurs in Topology Services when 
you:

1. Setup a tunnel between two ATM devices and 
let the devices see each other as Interim Local 
Management Interface (ILMI) neighbors on 
their tunnel interfaces (subinterfaces) only.

2. Select Fabric view.

3. Select a device and its associated VP tunnel 
link.

4. Select Tools > Display VCs > Per device.

5. Click Get Info.

An error appears:

Failed to compute utilization for some 
or all rows

Workaround:

None.

Table 7 Topology Services Known Problems (continued)
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CSCin36950 Cannot view VCs in a tunnel 
from Topology Services main 
window.

This problem occurs in Topology Services when 
you:

1. Setup a tunnel between two ATM devices and 
let the devices see each other as Interim Local 
Management Interface (ILMI) neighbors on 
their tunnel interfaces (subinterfaces) only.

2. Select Fabric view.

3. Select a device and its associated VP tunnel 
link.

4. Select Tools > ATM Management > Display 
VCs > Per device.

The device or port chooser does not list 
subinterfaces.

Workaround:

None.

CSCin29281 Device Attribute of Cisco 
Catalyst 6000 devices does not 
display the IP address.

Device Attribute of Cisco Catalyst 6000 devices 
does not display the IP address of WS-X6624-FXS 
module.

Instead, Device Attribute displays the IP address 
of Supervisor engine.

This is because of a defect in the SNMP agent on 
the device. For more details, see CSCin33075.

Workaround:

None.

Table 7 Topology Services Known Problems (continued)
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CSCin27895 Topology Services does not 
show VLANs as active, if the 
switch is in NULL folder under 
VTP Domain.

Topology Services > VTP Domains > NULL 
folder shows VLANs in VTP server devices as 
inactive, if the VTP Domain name is not 
configured on the device.

Topology Services displays the VLANs as inactive 
although the state of the VLAN on the switch is 
active.

Workaround:

Either: 

• Configure VTP domain name in the device 
and rediscover.

Or

• Configure VTP domain mode of the device as 
transparent and rediscover.

CSCin22459 Topology Groups membership 
update does not work as 
expected.

This problem occurs in Topology Services when 
you:

1. Launch Custom Views for a group by 
selecting Campus Manager > Topology 
Services.

2. With the Custom Views window open, delete 
a device group using Topology Group 
Administration.

Custom View does not update automatically.

Workaround:

Re-open the Custom View window.

Table 7 Topology Services Known Problems (continued)
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CSCin01977 Position of devices connected to 
switch cloud changed after 
upgrade.

Switch clouds and fabrics represent the collection 
of LAN switches and ATM switches, respectively.

These logical entities are very specific to the 
currently discovered network. That is, if a new 
switch is discovered, you cannot uniquely identify 
a switch cloud/fabric across ANI databases.

Workaround:

None.

CSCef67937 Campus Manager does not show 
port as trunking if the port is part 
of the Channel.

This problem occurs when Cisco Catalyst 3750 
has a 12.1 EA software version.

When a port is part of channel and configured as 
trunk, Campus Manager does not display the port 
as trunking for Cisco Catalyst 3750 switches.

Workaround:

Upgrade Cisco Catalyst 3750 device to 
12.2(18)SE1 or later.

CSCeb68819 Topology Services does not 
display dual links.

When two devices with dual links are aligned 
vertically on top of each other, the co-ordinates of 
the vertices of both links become the same. 

If the devices are not vertical, Topology Map 
displays dual links. 

Workaround:

Relayout the maps using hierarchical or 
symmetrical layout, so that the devices do not 
align vertically.

Table 7 Topology Services Known Problems (continued)
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CSCea39271 Topology Services displays the 
devices connected to a UB 
Token-Ring Hub in the 
Unconnected Devices View.

CiscoWorks discovers Cisco Catalyst 4700 and 
Catalyst 4500 devices, but displays them under 
Unconnected Devices View, and not in Layer 2 
View.

Campus Manager cannot draw the map for the 
devices, as the routers are connected through a UB 
hub.

Workaround:

None.

CSCdw49136 Campus Manager cannot 
establish connection between 
ATM ELAN and Ethernet VLAN 
when you remove LEC from 
Cisco Catalyst 2900XL devices.

Initially, VLAN and ELAN are connected in 
Topology Services. When you remove LEC from 
Cisco Catalyst 2900XL devices, the connection 
between VLAN and ELAN is broken for 2900XL 
devices.

This is because of a bug on 2900XL agent devices, 
where it does not support CISCO-LEC-EXT MIB.

Workaround:

None

CSCdv41860 Fetching LANE component 
details displays an error 
AniSQLException.

In Topology Services, if you create a LANE 
component in an ATM switch (LS1010) and 
launch its view, all the Profile and Diagnosis menu 
items related to this component display the 
following error:

Internal error

Workaround:

None.
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CSCdt50619 Two devices, connected by 
multiple links, appear to be 
connected by only one link.

When two devices are connected by multiple links, 
and you rediscover either devices or links, all of 
the links are stacked on one another. 

This causes the devices to appear as if they are 
connected by only one link.

Workaround:

Perform a re-layout.

CSCdt27824 Entire list of ports in a VTP 
domain appear when you select 
certain Transparent VTP 
domains from the VLAN 
Assignment dialog box.

When similar VLAN definitions exist on a VTP 
server and transparent devices, VLAN is added 
under the parent folder and all transparent devices.

Thus, VLAN ports are displayed under all 
transparent devices.

Workaround:

Run Find Ports query and enter only device name 
or address to view ports for a particular device.

CSCdt18293 Visio drawing does not import 
cleanly into Microsoft Visio.

If you export a Topology map as a Visio drawing, 
it is not imported cleanly into Microsoft Visio.

Links are drawn out of place, and some incorrect 
links appear to be drawn between devices.

Workaround: 

Clean the Visio drawing manually after import.
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CSCdr11577 Virtual Circuit (VC) error chart 
is blank.

A blank chart could mean either a continuous 
polling failure or a failure caused by other 
problems. 

For example, a blank VC error chart might be 
caused by a continuous polling failure (of VC 
error related data). 

It could also be because these statistics may not be 
supported on certain image versions of the ATM 
switch, being polled.

Workaround:

None.

CSCdp88318 Link attributes are not updated 
after a change is made.

If you change link attributes, ANI Server does not 
properly discover and display the change in 
reports. 

Workaround:

To update link attributes, close and relaunch 
Topology Services.

Table 7 Topology Services Known Problems (continued)
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ANI Server Known Problems
The table below lists the ANI Server related known problems in Campus Manager.

Table 8 ANI Server Known Problems

Bug ID Summary Explanation

CSCsc43106 Device not discovered if 
SysUpTime is masked.

If the SysUpTime in masked in v1default view, 
Device Discovery does not discover the device.

Workaround:

Manually add the devices to DCR.

Or

Remove the mask in v1 default view.

CSCsa20827 Subnet based groups are not 
deleted from Campus Manager 
Topology Groups although 
you delete them from DCR.

In DCR, if you delete all devices or all devices in a 
subnet, the corresponding subnet based groups in 
Campus Manager are not deleted immediately.

Workaround:

If you want the subnet groups to be deleted earlier 
than 20 minutes, change the property from:

SubnetPollerConfigTime = 1200000 

to a lesser value in the properties file:

NMSROOT/MDC/tomcat/webapps/campus/WEB-I
NF/classes/CM_Implementation_Details.properties.
43
Release Notes for Campus Manager 4.0.6 on Windows

OL-11282-01



 

Known Problems
CSCsa19337 ANI goes into Unknown State 
when you delete all devices 
from DCR.

This problem occurs in ANI when you:

1. Discover some devices by specifying seed 
devices in Campus Manager.

The DCR is updated with those devices.

2. Run data collection on those devices.

3. Invoke Topology Services. 

Devices appear in Views.

Deleting all devices from DCR will show ANI state 
and UT state as Unknown although you specify the 
seed devices in Device Discovery settings.

Workaround:

None.

CSCin74855 Device not managed in 
Campus Manager if 
management IP is not in ACS.

This problem is seen in ANI.

If a device has multiple IP addresses, 
Campus Manager automatically determines the 
management IP address of the device. 

If the management IP address is not ACS (that is, the 
device is added in ACS with a different address), this 
device is not managed in Campus Manager. Data 
collection is not done for this device.

Workaround:

IP address in ACS and management IP address in 
DCR should be the same.

CSCin33112 Cannot delete devices on a 
remote system in SSL mode 
using the command line 
interface.

The Delete Device command fails if you use it on 
a remote server in the SSL mode.

Workaround:

None.
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CSCdy31689 User Tracking Discovery stops 
responding when you refresh 
discovery metrics page.

In large networks, sometimes, when you refresh 
discovery metrics page, ANI hangs after partially 
completing device discovery, and does not display 
any high CPU usage. 

The is because of a known problem in JRE caching 
of DNS look ups.

Workaround:

1. Stop the Daemon Manager.

2. Edit the registry for:

HKEY_LOCAL_MACHINE\SOFTWARE\
Cisco\Resource Manager\CurrentVersion\
Daemons\ANIServer\Args

3. Modify the value of:

-cp:a C:\PROGRA~1\CSCOpx\lib\classpath\
servlet.jar -Dvbroker.orb.gcTimeout=90 
-mx512m 
com.cisco.nm.ani.server.frontend.AniMain

to

-Xminf0.1 -Xmaxf0.1 -cp:a 
C:\PROGRA~1\CSCOpx\lib\classpath\
servlet.jar -Dvbroker.orb.gcTimeout=90 
-Dsun.net.inetaddr.ttl=0 -mx1024m 
com.cisco.nm.ani.server.frontend.AniMain

4. Start Daemon Manager.
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CSCdw67129 Topology Services cannot 
resolve the hostname of newly 
discovered devices.

If you add the DNS entry for the devices after initial 
discovery, Topology Services cannot resolve the 
hostname of the newly discovered devices. 

The subsequent discoveries do not resolve the IP 
address to a hostname until the ANIServer reloads.

This occurs only in devices that do not have a DNS 
entry before discovery. Devices that have a DNS 
entry before ANI discovers them, do not have this 
problem.

Workaround:

Do either of the following: 

• Restart CiscoWorks Server. ANI resolves the 
IP address to a hostname after restart.

Or

1. Display the sysName in Topology Services 
(does not require a restart). 

2. Select Topology Services > Layer 2 View > 
View > Display Labels > Show Sysname

Alternatively, you can do any of the following:

• Run Device Discovery again.

• Stop and start the ANIServer.

• If you require Campus Manager to ignore the 
cache and always look up the DNS server, add 
the following variable in the Java command line 
of the ANIServer:

Dnetworkaddress.cache.ttl=0
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CSCdt20329 ATM switches, for which 
Remote Monitoring (RMON) 
is enabled, are not highlighted 
when Show Enabled Devices 
is selected.

This problem occurs when you:

1. Select Topology Services.

2. Highlight an ATM fabric under Managed 
Domains/ATM Domains

3. Select Display View.

4. Select devices, and click Tools > RMON Data 
Collection > Show Enabled Devices

Workaround:

None.

CSCdp76410 Campus Manager client 
cannot connect to server using 
proxies.

Campus Manager does not support proxies.

Workaround:

None

CSCdm58624 Campus Manager reports VTP 
Disconnected Domain 
discrepancy when VTP 
Domain is configured across a 
LANE Trunk.

Campus Manager reports Disconnected Domain 
discrepancy even when VTP domain is configured 
across ATM cloud and the default ATM-VLAN is 
configured to carry VTP advertisements across the 
cloud.

Workaround:

Ignore the discrepancy.

CSCdm48015 Campus Manager displays an 
ATM trunk port as configured 
to a VLAN, even if there is no 
corresponding LANE client 
associated with that VLAN.

In VLAN-to-port association, all ATM ports on 
switches (except the ATM switches) configured to 
the VLAN appear.

Workaround:

Ignore ATM ports in VLAN-to-port association.

CSCdp00593 SNMP report displays wrong 
HwVersion and 
HwVersionMinor for Cisco 
LS1010 devices.

This is because the image has reached EOE.

Workaround:

Enter show hardware in the command line interface 
of Cisco LS1010 devices.

Table 8 ANI Server Known Problems (continued)

Bug ID Summary Explanation
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VLAN Port Assignment Known Problems
The table below lists the VLAN Port Assignment related known problems in 
Campus Manager.

CSCdm91634 In Campus Manager device 
report, number of ports in a 
device’s ATM module are 
incorrectly displayed as zero.

This problem occurs in Catalyst 5000 devices 
running Catalyst operating system software 
release 4.3(1a). It is caused by missing if Entry for 
device ATM module. 

ANI Server depends on ifEntry to determine number 
of ports in a particular module.

Workaround:

None.

Table 8 ANI Server Known Problems (continued)

Bug ID Summary Explanation

Table 9 VLAN Port Assignment Known Problems

Bug ID Summary Explanation

CSCsc24275 VLAN interfaces created 
through IVR are not shown in 
the existing interface list for 
that device.

If the corresponding VLAN on which the new 
VLAN interface is being created does not already 
exist in the device, the interface is not shown in the 
list.

Workaround:

Create a VLAN in the device before you create 
VLAN interfaces.

Or 

Create interfaces for existing VLANs in the device.
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CSCin67286 Topology Services cannot 
populate PVLAN to port 
association for some ports in 
Cisco Catalyst 4000 IOS 
devices.

If the ports are inactive Topology services does not 
show PVLAN to port association in Cisco Catalyst 
4000 IOS devices.

Workaround:

Upgrade the IOS image to 12.2(25)EWA or later.

CSCdw09818 Port Attribute in VLAN Port 
Assignment displays incorrect 
information.

This problem is observed only on inactive ports. The 
MIB values returned by the devices latch on to the 
previous speed and duplex properties.

This is because of a defect in SNMP agent of the 
device. 

Workaround: 

None.

Table 9 VLAN Port Assignment Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
Spanning Tree Protocol Known Problems
The table below lists the Spanning Tree Protocol related known problems in 
Campus Manager.

Table 10 Spanning Tree Protocol Known Problems

Bug ID Summary Explanation

CSCsa12292 VLANs not loaded for STP 
Offline Computation.

This problem occurs in STP when you:

1. Launch STP Offline for PVST From the 
Topology Map.

2. Go to Reports > VLAN STP 
Recommendations > STP Offline

3. Click Select Instance

No VLANs are loaded.

Devices that do not support 
CISCO-STP-EXTENSIONS-MIB will not support 
any STP related functionality.

Workaround:

None.

CSCsa09287 Cannot map VLANs to 
instance if the device runs 
MISTP.

In STP, if the device is running STP type as MIST, 
configuring the instance to VLAN mapping from 
STPConfiguationReport > InstanceTab is not 
applied on the device. 

This is caused by an SNMP Agent problem.

Workaround:

None.
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Resolved Problems in Campus Manager 4.0.6
The following table lists the problems that have been fixed in Campus Manager 
4.0.6.

CSCin67279 Community suffix support is 
not available for MST on 
Cisco IOS switches.

In STP, community suffix support is not available for 
MST and MISTP on Cisco IOS switches.

Workaround:

None.

CSCed72194 MST device report does not 
report CIST root correctly.

In STP, MST device report may not report the CIST 
root properly.

This is because the dot1dStpDesignatedRootCost 
object corresponds to external root path cost. Hence 
the value of the object is 0 for all switches in the 
MST region that contains CIST root.

Workaround:

None.

Table 10 Spanning Tree Protocol Known Problems (continued)

Bug ID Summary Explanation

Table 11 Resolved Problems in Campus Manager 4.0.6

Bug ID Summary Additional Information

CSCeg75854 Campus Manager did not support 
WS-X6582-2PA flexwan card.

This problem has been resolved.

CSCsa52136 Wake On LAN was not supported in 
User Tracking.

This problem has been resolved.

CSCsa83447 You could not delete multiple 
community strings at the same time. 
This was because you could select only 
one radio button.

This problem has been resolved.

The Radio buttons have been replaced by 
check boxes. You can select multiple 
community strings by selecting the check 
boxes.
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CSCsb16407 Name of the new groups created based 
on SystemContact and SystemLocation 
was case sensitive.

This problem has been resolved.

Now you can specify group names which 
are not case sensitive.

CSCsb52555 You could not schedule quarterly jobs 
for User Tracking Custom Reports. 
Also, there was no e-mail notification.

This problem has been resolved.

You can now schedule quarterly jobs for 
User Tracking Custom Reports. E-mail 
notification containing the URL of the 
report is also supported.

CSCsc17087 You could not perform selective Data 
Collection for new devices alone. 

This problem has been resolved.

You can now perform selective Data 
Collection either for All Devices or  for 
New Devices only.

CSCsc24107 Last Seen Column filter in User 
Tracking Custom Reports was not 
working properly.

This problem has been resolved.

For more details, see the section Operator 
Values for Last Seen Column in Campus 
Manager Online Help.

CSCsc51917 Although you could create group 
names with special characters, you 
could not select or edit them.

This problem has been resolved.

You cannot create group names with special 
characters.

CSCsc61310 Path Analysis could not handle 
switches with Multi Layer Switch 
Feature Card (MSFC).

This problem has been resolved.

CSCsd65038 User Tracking reports leaked database 
connections. 

This happened when database connection 
was not closed properly because of the 
errors while running User Tracking reports.

This problem has been resolved.

CSCsd73842 Campus Manager 4.0 did not support 
Auxiliary VLANs on Cisco Catalyst 
4000 Series.

This problem has been resolved.

Campus Manager  now supports Auxiliary 
VLANs on Cisco Catalyst 4000 Series.

Table 11 Resolved Problems in Campus Manager 4.0.6 (continued)

Bug ID Summary Additional Information
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CSCsd79426 When you started Campus Manager 
applications, the status of ANI server 
was always reported to be initializing.

This problem has been resolved.

This happens if the LogMsg.logfile 
property in NMSROOT/campus/etc/cwsi/
ANIServer.properties pointed to a directory 
rather than a file.

CSCsd82813 utdebug did not work with certain 
fixed-configuration IOS switches.

This problem has been resolved.

CSCsd89046 Campus Manager could not list the 
unreachable devices.

This problem has been resolved.

CSCsd99630 Campus Manager Data Collection did 
not complete successfully.

This problem has been resolved.

CSCsd99642 Campus Manager daemons ran out of 
memory while loading the ANI 
database.

This problem has been resolved.

CSCse03007 You could not export a Visio XML file 
from the Topology Map LAN Edge 
View.

This problem has been resolved.

This problem occurred when you selected a 
cloud object such as witch clouds and ATM 
fabric clouds for export. 

CSCse09907 You had to redo Data Collection if 
ANIServer was restarted.

This problem has been resolved.

CSCse11889 The ani.log file did not get backed up as 
ani.log_backup when ANI process was 
restarted.

This problem has been resolved.

CSCse13232 You wanted to by-pass 
InetAddress.getHostName() and 
directly go for JNDI look up.

This problem has been resolved.

CSCse14478 ANI processes stopped because of 
some unwanted blocking calls that 
locked the VTP Domain and VLAN 
objects.

This problem has been resolved.

CSCse17014 User Tracking added duplicate entries 
during major acquisition.

This problem has been resolved.

Table 11 Resolved Problems in Campus Manager 4.0.6 (continued)

Bug ID Summary Additional Information
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CSCse22299 Data Collection and User Tracking 
Acquisition ignored large SNMP 
timeout values.

This problem has been resolved.

CSCse29553 In the Online Help, Duplicate SysName 
was listed in Physical Discrepancies 
instead of Logical Discrepancies.

This problem has been resolved.

CSCse32030 User Tracking did not function when 
you migrated from SNMPv3 to 
SNMPv2.

This problem has been resolved.

CSCse34643 Campus Manager did not support 
auxiliary VLANs on Cisco Catalyst 
3550 Series devices. 

This resulted in getting incomplete 
information on IP Phones connected to 
Cisco Catalyst 3550 Series devices 
with auxiliary VLANs.

This problem has been resolved.

CSCse41622 When you connected IP Phones to 
trunk ports, the User Tracking Phone 
Report showed duplicate entries for the 
same extension.

This problem has been resolved.

CSCse43345 When you deleted a device from DCR, 
the event was not sent to Campus 
Manager. So the device existed in ANI, 
but not in DCR. 

As a result, ANI hung and User 
Tracking failed.

This problem has been resolved.

Table 11 Resolved Problems in Campus Manager 4.0.6 (continued)

Bug ID Summary Additional Information
54
Release Notes for Campus Manager 4.0.6 on Windows

OL-11282-01



 

Resolved Problems in Campus Manager 4.0.6
CSCse47733 Cisco Catalyst 6000 Series devices 
were displayed in Unconnected View of 
Campus Manager 4.0.4 Topology 
Services. 

This happened although CDP-MIB 
responded properly to SNMP queries 
and had corresponding entries on 
neighboring devices.

This problem has been resolved.

CSCse48823 Online Help did not contain 
information on Visio 2003 support in 
Campus Manager. 

Online Help and User Guide have been 
updated.

This problem has been resolved.

CSCse68260 User Tracking queried for suspended or 
otherwise non-operational VLANs. 
This resulted in triggering 
Authentication failure traps

This problem occurred when:

• Any non-operational VLANs on a 
specified switch contained 
operationally up ports. 

• Any non-operational VLANs on a 
specified switch contained any ports, 
and the UTGetVlansOnDownPorts 
property was not set to ‘0’ in the 
ANIServer.properties file.

This problem has been resolved.

CSCse76357 You could not launch SSH from the 
Topology Map for MSFCs.

This problem has been resolved.

CSCse92940 Campus did not manage logical 
interfaces on Catalyst 6000/76xx 
routers.

Campus manages only the physical 
interfaces existing in the device hardware 
which will be populated by the entity mib.

So the links were not displayed in the 
topology map if those devices were 
connected to neighbor devices through 
these logical interfaces.

This problem has been resolved.

Table 11 Resolved Problems in Campus Manager 4.0.6 (continued)

Bug ID Summary Additional Information
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CSCse91697 Data Collection and User Tracking ran 
for a long time.

This happened when SNMPv3 was being 
used, and when there were corrupt cache 
entries in either 
NMSROOT/campus/etc/cwsi/
Snmpv3EngineParam.txt or 
UTSnmpv3EngineParam.txt.

This problem has been resolved.

CSCsd32162 Sorted order was not retained in User 
Tracking exported data. 

This problem has been resolved.

CSCse95701 Layer 2 view of Topology Services 
showed a shared media link, when a 
switch was connected to a router 
interface of type l2vlan.

This problem has been resolved.

CSCse98258 ANIServer  crashed with  Java HotSpot 
Virtual Machine error. 

This problem has been resolved.

CSCsf01061 Data collection generated 
Authentication failure traps while 
querying inactive VLANs.

This problem has been resolved.

CSCsf09634 Campus Manager applications such as 
Topology Services and Path Analysis 
did not start if the HTTP port for 
CiscoWorks was set to 80. 

This problem has been resolved.

CSCsf00966 User Tracking reported duplicate 
entries for end hosts connected to 
uplink ports on Catalyst 4000 IOS 
switches.

This problem has been resolved.

Table 11 Resolved Problems in Campus Manager 4.0.6 (continued)

Bug ID Summary Additional Information
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Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco 
also provides several ways to obtain technical assistance and other technical 
resources. These sections explain how to obtain technical information from Cisco 
Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
Cisco documentation and additional literature are available in the Product 
Documentation DVD package, which may have shipped with your product. The 
Product Documentation DVD is updated regularly and may be more current than 
printed documentation.

The Product Documentation DVD is a comprehensive library of technical product 
documentation on portable media. The DVD enables you to access multiple 
versions of hardware and software installation, configuration, and command 
guides for Cisco products and to view technical documentation in HTML. With 
the DVD, you have access to the same documentation that is found on the Cisco 
website without being connected to the Internet. Certain products also have .pdf 
versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. 
Registered Cisco.com users (Cisco direct customers) can order a Product 
Documentation DVD (product number DOC-DOCDVD=) from Cisco 
Marketplace at this URL:

http://www.cisco.com/go/marketplace/
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Documentation Feedback
Ordering Documentation
Beginning June 30, 2005, registered Cisco.com users may order Cisco 
documentation at the Product Documentation Store in the Cisco Marketplace at 
this URL:

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. 
to 5:00 p.m. (0800 to 1700) PDT by calling 1 866 463-3487 in the United States 
and Canada, or elsewhere by calling 011 408 519-5055. You can also order 
documentation by e-mail at tech-doc-store-mkpl@external.cisco.com or by fax at 
1 408 519-5001 in the United States and Canada, or elsewhere at 011 408 
519-5001.

Documentation Feedback
You can rate and provide feedback about Cisco technical documents by 
completing the online feedback form that appears with the technical documents 
on Cisco.com.

You can send comments about Cisco documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front 
cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
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Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

From this site, you can perform these tasks:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at 
this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you 
can access a Product Security Incident Response Team Really Simple Syndication 
(PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally 
before we release them, and we strive to correct all vulnerabilities quickly. If you 
think that you might have identified a vulnerability in a Cisco product, contact 
PSIRT:

• Emergencies— security-alert@cisco.com

An emergency is either a condition in which a system is under active attack 
or a condition for which a severe and urgent security vulnerability should be 
reported. All other conditions are considered nonemergencies.

• Nonemergencies— psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532
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Obtaining Technical Assistance
Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to 
encrypt any sensitive information that you send to Cisco. PSIRT can work from 
encrypted information that is compatible with PGP versions 2.x through 8.x. 

Never use a revoked or an expired encryption key. The correct public key to use 
in your correspondence with PSIRT is the one linked in the Contact Summary 
section of the Security Vulnerability Policy page at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

The link on this page has the current PGP key ID in use.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical 
assistance. The Cisco Technical Support & Documentation website on Cisco.com 
features extensive online support resources. In addition, if you have a valid Cisco 
service contract, Cisco Technical Assistance Center (TAC) engineers provide 
telephone support. If you do not have a valid Cisco service contract, contact your 
reseller.

Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online 
documents and tools for troubleshooting and resolving technical issues with Cisco 
products and technologies. The website is available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website 
requires a Cisco.com user ID and password. If you have a valid service contract 
but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do
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Obtaining Technical Assistance
Note Use the Cisco Product Identification (CPI) tool to locate your product serial 
number before submitting a web or phone request for service. You can access the 
CPI tool from the Cisco Technical Support & Documentation website by clicking 
the Tools & Resources link under Documentation & Tools. Choose Cisco 
Product Identification Tool from the Alphabetical Index drop-down list, or click 
the Cisco Product Identification Tool link under Alerts & RMAs. The CPI tool 
offers three search options: by product ID or model name; by tree view; or for 
certain products, by copying and pasting show command output. Search results 
show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the 
information before placing a service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 
service requests. (S3 and S4 service requests are those in which your network is 
minimally impaired or for which you require product information.) After you 
describe your situation, the TAC Service Request Tool provides recommended 
solutions. If your issue is not resolved using the recommended resources, your 
service request is assigned to a Cisco engineer. The TAC Service Request Tool is 
located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the 
Cisco TAC by telephone. (S1 or S2 service requests are those in which your 
production network is down or severely degraded.) Cisco engineers are assigned 
immediately to S1 and S2 service requests to help keep your business operations 
running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts
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Obtaining Additional Publications and Information
Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has 
established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your 
business operations. You and Cisco will commit all necessary resources around 
the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or 
significant aspects of your business operation are negatively affected by 
inadequate performance of Cisco products. You and Cisco will commit full-time 
resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most 
business operations remain functional. You and Cisco will commit resources 
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product 
capabilities, installation, or configuration. There is little or no effect on your 
business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, 
documentation, and logo merchandise. Visit Cisco Marketplace, the company 
store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training and 
certification titles. Both new and experienced users will benefit from these 
publications. For current Cisco Press titles and other information, go to Cisco 
Press at this URL:

http://www.ciscopress.com
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Open Source License Acknowledgements
• Packet magazine is the Cisco Systems technical user magazine for 
maximizing Internet and networking investments. Each quarter, Packet 
delivers coverage of the latest industry trends, technology breakthroughs, and 
Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, 
certification and training information, and links to scores of in-depth online 
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to 
help growing companies learn how they can use technology to increase 
revenue, streamline their business, and expand services. The publication 
identifies the challenges facing these companies and the technologies to help 
solve them, using real-world case studies and business strategies to help 
readers make sound technology investment decisions. 

• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in designing, developing, and 
operating public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• Networking products offered by Cisco Systems, as well as customer support 
services, can be obtained at this URL:

http://www.cisco.com/en/US/products/index.html

• Networking Professionals Connection is an interactive website for 
networking professionals to share questions, suggestions, and information 
about networking products and technologies with Cisco experts and other 
networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

• World-class networking training is available from Cisco. You can view 
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html

Open Source License Acknowledgements
The following acknowledgements pertain to this software license.
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Open Source License Acknowledgements
OpenSSL/Open SSL Project
This product includes software developed by the OpenSSL Project for use in the 
OpenSSL Toolkit (http://www.openssl.org/).

This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com).

This product includes software written by Tim Hudson (tjh@cryptsoft.com).

License Issues

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the 
OpenSSL License and the original SSLeay license apply to the toolkit. See below 
for the actual license texts. Actually both licenses are BSD-style Open Source 
licenses. In case of any license issues related to OpenSSL please contact 
openssl-core@openssl.org.

OpenSSL License:

© 1998-1999 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, 
are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions, and the following disclaimer in the documentation 
and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must 
display the following acknowledgment: “This product includes software 
developed by the OpenSSL Project for use in the OpenSSL Toolkit. 
(http://www.openssl.org/)”

4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to 
endorse or promote products derived from this software without prior written 
permission. For written permission, please contact 
openssl-core@openssl.org.

5. Products derived from this software may not be called “OpenSSL” nor may 
“OpenSSL” appear in their names without prior written permission of the 
OpenSSL Project.
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Open Source License Acknowledgements
6. Redistributions of any form whatsoever must retain the following 
acknowledgment:

“This product includes software developed by the OpenSSL Project for use in 
the OpenSSL Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS”' AND 
ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com).

Original SSLeay License:

© 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This package is an SSL implementation written by Eric Young 
(eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the 
following conditions are adhered to. The following conditions apply to all code 
found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the 
SSL code. The SSL documentation included with this distribution is covered by 
the same copyright terms except that the holder is Tim Hudson 
(tjh@cryptsoft.com).
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Open Source License Acknowledgements
Copyright remains Eric Young’s, and as such any Copyright notices in the code 
are not to be removed. If this package is used in a product, Eric Young should be 
given attribution as the author of the parts of the library used. This can be in the 
form of a textual message at program startup or in documentation (online or 
textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, 
are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation 
and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must 
display the following acknowledgement:

“This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com)”.

The word ‘cryptographic’ can be left out if the routines from the library being 
used are not cryptography-related.

4. If you include any Windows specific code (or a derivative thereof) from the 
apps directory (application code) you must include an acknowledgement: 
“This product includes software written by Tim Hudson 
(tjh@cryptsoft.com)”.

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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Open Source License Acknowledgements
The license and distribution terms for any publicly available version or derivative 
of this code cannot be changed. i.e. this code cannot simply be copied and put 
under another distribution license [including the GNU Public License].

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, 
command display output, and figures included in the document are shown for illustrative purposes only. Any use of 
actual IP addresses in illustrative content is unintentional and coincidental.

© 2006 Cisco Systems, Inc. All rights reserved.

CCVP, the Cisco logo, and Welcome to the Human Network are trademarks of Cisco Systems, Inc.; Changing the Way 
We Work, Live, Play, and Learn is a service mark of Cisco Systems, Inc.; and Access Registrar, Aironet, Catalyst, 
CCDA, CCDP, CCIE, CCIP, CCNA, CCNP, CCSP, Cisco, the Cisco Certified Internetwork Expert logo, Cisco IOS, 
Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo, Cisco Unity, Enterprise/Solver, 
EtherChannel, EtherFast, EtherSwitch, Fast Step, Follow Me Browsing, FormShare, GigaDrive, HomeLink, Internet 
Quotient, IOS, iPhone, IP/TV, iQ Expertise, the iQ logo, iQ Net Readiness Scorecard, iQuick Study, LightStream, 
Linksys, MeetingPlace, MGX, Networkers, Networking Academy, Network Registrar, PIX, ProConnect, ScriptShare, 
SMARTnet, StackWise, The Fastest Way to Increase Your Internet Quotient, and TransPath are registered trademarks 
of Cisco Systems, Inc. and/or its affiliates in the United States and certain other countries. 

All other trademarks mentioned in this document or Website are the property of their respective owners. The use of the 
word partner does not imply a partnership relationship between Cisco and any other company. (0711R)
67
Release Notes for Campus Manager 4.0.6 on Windows

OL-11282-01



 

Open Source License Acknowledgements
68
Release Notes for Campus Manager 4.0.6 on Windows

OL-11282-01


	Release Notes for Campus Manager 4.0.6 on Windows
	New Features
	Enhanced Homepage
	Setup Center
	Enhanced Device Selector

	Product Documentation
	Related Documentation
	Additional Information Online
	Support Information
	Known Problems
	General Notes and Known Problems
	General Known Problems
	Browser Known Problems
	Path Analysis Known Problems
	User Tracking Known Problems
	Topology Services Known Problems
	ANI Server Known Problems
	VLAN Port Assignment Known Problems
	Spanning Tree Protocol Known Problems

	Resolved Problems in Campus Manager 4.0.6
	Obtaining Documentation
	Cisco.com
	Product Documentation DVD
	Ordering Documentation

	Documentation Feedback
	Cisco Product Security Overview
	Reporting Security Problems in Cisco Products

	Obtaining Technical Assistance
	Cisco Technical Support & Documentation Website
	Submitting a Service Request
	Definitions of Service Request Severity

	Obtaining Additional Publications and Information
	Open Source License Acknowledgements
	OpenSSL/Open SSL Project
	License Issues





<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


